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Excel 2016: Charts and Graphs

2.0 hours

This workshop assumes prior experience with Excel, Basics | recommended. Topics
include data groupings; creating and modifying charts; chart types; source data; chart
options; chart locations; formatting; adding trend lines and error bars.
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Charts

A chart helps you display your data into a graphical representation. There are many types of charts, but in this
class we'll focus on simple column, line, and pie charts. There are examples of other charts near the end of this
handouts.

The first thing to know is the data has to be organized so Excel can understand what you are trying to chart.
Excel will chart your data selection or your connected data range. As long as there are no blank columns and no
blank rows within your dataset, you can skip selecting the cells.
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Here is a dataset we will use in class:

Item 1st Qtr 2nd Qtr 3rd Qtr 4th Qtr
Pants 456 489 423 468
Shoes 498 435 472 436
Socks 128 168 157 138
Blouses 579 498 531 589
Hats 126 129 123 119

This is a structured collection of related data set in a table
format. When plotted onto a clustered column chart, like the Line
one shown above, the titles in the first column of the dataset ”
appear along our category axis. The titles in the first row M

appear within the legend. The values are represented by the ' éé

400
height of each column. 300

200

Line charts are usually set up to go across a period of time, e
think Time Line. For this chart I've used the Switch Row : 1stQu 2nd Qe 3rd ath ar
Column tool so we can see the trend of the sales through the ——Pants mmShoes —mSocks smmBloUses emHals

year. In this case our first column titles appear in the legend,
and the first row of titles appears in our category axis.

Pie

Pie charts are usually created to display the breakdown of
the total values within the whole. Pie charts can only be
based on one set of data. When you try to create one with
the above dataset, you will only see the first value set appear
within the chart. If you want to go to an extreme and have all
four quarters show, try using a Doughnut chart.

= Pants = Shoes = Socks = Blouses = Hats
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Creating a Chart
To create a chart make sure your cursor is in the dataset you would like to plot. If you want a subset of the

dataset, select that portion. You can use your Ctrl key to add to a current selection.

You will find the Charts group on the Insert tab. Click on any small chart button to see a list of possible charts.
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If you are unsure of the best chart option for your data use the Recommend Charts button. It will open the
Insert Chart window shown here.
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|| ‘ Il | || | II ‘ A clustered column chart is used to compare values across a few categories. Use it
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Chart Tools
When you select a chart, three buttons appear along the right side of the selection.

(o] O o] +
Chart Title
700 i}.‘
G600
Y
500
400
0200 o)
200
“ ] i
0
Pants Shoes Socks Blouses Hats
N 1st Qtr m2nd Qfr 3rd Qtr m4th Qtr
O O O
“::‘“’“""5 The plus sign is the Add Chart Element button. This option is used to add and
| O s Tites remove different pieces of your chart. The list of options will vary depending on
e ':b"icd"o“ly the type of chart. For example, a pie chart will not have a set of category axis
S o Tooe More Opions. titles. As you hover your mouse over each option, you will see a small arrow head
Gridiines pointing to the right. This will open another menu with more detailed choices.
! egen n H n H 5
o Each menu also has a "More Options..." button which will open a Format Pane on
to customize each chart element.
Style Color Style Color
T . G Titke - T Colorful -
- B ER There is a Chart Style Gallery and a Colors menu on the
: “ | "I " ||| . P ] Design tab, but the Chart Styles button, the paint brush
“ ] .
S s o EETEER next to the chart, offers the same options.
e Mﬁ“ﬁ"i“‘. If you are patient while you hover over each option, Excel
|| | " | || | will provide you with a Live Preview of the result.
| i 1 ....
===. The Color options are available at the top of the menu.
How do I change these colors?
Q| Values | Names N voves Names The third button is a funnel. This is a Chart Filters button.
4 Series 4 Series
V| (Select All) ® Row1l
0 o 151.Qtr, 2nd Qu, 3rd Q. The Values group allows you to add and remove data
41 2:nd Qe fHere points from the chart.
v 3rd Qir 4 Categories
® Column A
A W ahQ Pants, Shoes, Sacks, Blou. The Names page allows you to change the labels that
4 Categories (None) . . . .
7 select Al appear in the legend (series) and axis titles (category).
¥ Pants
< Shoes The Select Data... option at the bottom of the window
o socks opens the same window as the Select Data button on the
< Blouses Design tab. From there you can change or adjust the
e range of cells used to create this chart.
Apply Select Data... Apply Select Data...
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Chart Tool Tabs

When a chart is selected two chart tool tabs appear at the end of the ribbon, Design and Format.

Design Tab
Add Chart Quick Change “ | ||I s I L ‘H ”I ifii m Tl ll_ln-i-ﬂ[-'-.-‘- I]”III"" | L] “ E |” ilie | L — | Switch Row/ Select Change = Move
Element ~ Layout~ Colors~ Column Data Chart Type Chart
Chart Layouts Chart Styles Data Type Location
1 2 3 4 5 6 7 8

1. Add Chart Element — A menu of chart elements that can be added or removed to the chart. Each option
will have a expand arrow at the end of the element name that will provide specifics and a More Options
button to open the Format Pane. This is the same as the Add Chart Element button that appears next to

the selected chart.

2. Quick Layout -

— A variety of layouts that offer suggested views and choices that adjust the chart

elements such as adding a title, varying the space between columns, and moving the legend.

3. Change Colors — Different color that can be applied to your chart. Changing the Theme on the Page

Layout tab will give you a different sets of colors.

4. Chart Style Gallery — Different chart styles that can be applied to your chart. Because Excel
automatically adjusts the Ribbon to fit on your screen, your copy of Excel may show less options than
the picture above. Use the scroll arrows and open menu buttons at the right side of the gallery for more.

5. Switch Row/Column — Changes the direction the chart looks at| Item 1stQtr | 2nd Qtr | 3rd Qtr | 4th Qtr
the data. In our column chart, each column is plotted on the gﬁgtess jgg igg fég 222
chart, when we Switch each row is plotted. We are swapping | Socks 128 168 157 138
the category labels with the legend labels. Eg’tises i;g igg igé iig

Chart Title Chart Title

600 600

500 500 m Pants
400 48 . “." 400

300 -'I“I:-):I 00

200 m ath Qtr 200 :{I [W:IIJ
o8 NTR NI

e o e s

6. Select Data — Opens a Select Data Source window e O - "'?3"‘
where you can customize the source of the chart e [ E— =
data, even edit the labels. Use this window to S
reorder your legend and change how Line charts deal || cowdemies series _Hmm...u,;,,qﬂw,.[..b,...
with blank cell values. g e 2o~ |z LG

7. Change Chart Type — Opens Insert Chart window S .o
where you can change to other chart types. If you 7 o ot
have multiple series you can change each to be e v e ot e X
different chart type by choosing the Combo chart : — |
type from the bottom of the left pane. Move Chart 7

8. Move Chart — By default when you create a chart it is h|;d|ym::mhw
placed on the same worksheet as your data set. You can
move the chart to its own worksheet or to any existing |jﬂ 9 gbjectin -]
worksheet with the workbook. =
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Format Tab

Chart Area - N £ Shape Fill - |2 Align - IS
{Z'.‘ Format Selection Oo9g - ﬂ 7 L# Shape Outline ~ A A A *

3 Reset to Match Style AL L= = | &¥ Shape Effects - A~ DQ Selection Pane oy 3

Current Selection Insert Shapes Shape Styles ] WordArt Styles IF] Arrange Size 7]

1. Current Selection

a. Chart Elements — This box shows the currently selected Chart Element, and the menu provides a
list of the major chart elements. Choose an item from this list to select that element.

b. Format Selection — Opens the Format Pane based on the current selection shown in the Chart
Elements box.

c. Reset to Match Style — Changes the current selection to match the original style of the chart.

2. Insert Shape

a. Shape Gallery — Use this gallery to find a shape such as a block arrow to add
to your chart.

b. Change Shape — Use this tool to change the current shape to a different one,
perhaps a rectangle into a rounded rectangle.

3. Shape Styles
a. Style Gallery — Different shape styles, options will vary based on

the current selection. :|
b. Shape Fill - Menu of the most common fill colors and options, n ﬂ ﬂ [:] ﬂ ﬂ [:]
- -

such as pictures and textures. For more options, open the Ao
Format Pane.

c. Shape Outline — Menu of the most common outline colors and
options, such as dashes and arrows. For more options open the ﬂ
Format Pane.

d. Shape Effects — Menu of the most common shape effects, such
as shadows. For more options open the Format Pane.

4. WordArt Styles

a. WordArt Gallery — Different WordArt styles

b. Text Fill - Menu of the most common fill colors and options, A
such as pictures and textures. A
A

c. Text Outline — Menu of the most common outline colors and
options, such as dashes and line weight.

d. Text Effects — Menu of the most common Text effects, such as A A & I &
shadows. For more options open the Format Pane.

5. Arrange — Change the alignment and arrangement of multiple charts. Use the Shift key to select more
than one chart at a time.

6. Size — Change the height and width of the chart.
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Format Pane
There are multiple ways to open the Format Pane.

e Click on the Format Selection button in the Format tab
e C(Click on More option from any menu

e Right-click on a chart element and choose Format...

e Double-click on a chart element

The format pane can remain open for as long as you need it. The properties shown change depending on the
current selection. The current selection is shown on the Format tab and in the title of the Format Pane.

The pane can be pulled free from the side by dragging the title toward the middle of the window. To return the
pane to the side of the window drag it back into place or double-click the title of the Format Pane.

To close the pane, click on the X in the upper right hand corner. If you accidentally close the pane, use any
method above to reopen it.

Within the Format Pane, click on each icon to see the subset of properties. Click on the expand arrow in front of
the options to see the relevant properties.

Format Axis v X Format Axis 2 oS
Axis Options V] Text Options Axis Options =
il A 4
b Fill | Text FN\
I* Line Il Text OQutline
I \ N | N\
Fill & Line Effects Size & Properties Options Text Fill & Outline Text Effects  Text Box Options

The Fill & Line and Effects options are the same for all the of the chart elements. If an option cannot be applied
to that chart element, Excel will disable (grey out) that option.

Below are the fill options for a Chart Element. Each Fill choice provides a new set of options.

4 Fill 4 Fill 4 Fill

STl

4 Fill

No fill
Solid fill
) Gradient fill

No fill
Solid fill
Gradient fill

No fill
Solid fill

No fill Gradient fill

Solid fill
Gradient fill

.

®) Picture or texture fill

Pattern fill

Picture or texture fill Picture or texture fill

Pattern fill ®) Pattern fill

Picture or texture fill Automatic Automatic Automatic

Pattern fill Invert if negative Invert if negative Invert if negative

Automatic

i iti 0%
Automatic Position

) ) Preset gradients D - Insert picture from Pattern
Invert if negative = Eile.. Clipboard Online... ! : ) G
Type Radial i - R
Color Q 7 Direction D - Texture & E ﬂ
D Y Y
Transparency | 0% z . Transparency | 0% B ZA ;\\\\\ % & //A
4 Border Gradient stops e Stretch
“ Notie 1 5] 5 Stck
Solid line Stack and Scale with
Color & S
Gradient line 1

Offset left 0% -




Howdol...?

Change Axis Numbers
Select the Axis by clicking on a number in the area. Open the Format pane, be sure the title says Format Axis.
Click on the Options button. m

From here you can:

e Change the Minimum and Maximum numbers shown. These can be greater than the minimum and less
than the maximum if you want.

e Change the Major unit, this is how the displayed number is chosen. If the major unit is 100 the chart axis
will read 100, 200, 300. If it's 25 the chart will show 25, 50, 75.

e Change the Display Units to Thousands, Millions, Billions. This will change the unit shown in the labels
and data tables as well.

e Change the Format of the numbers; number of decimals, include a dollar sign, etc.

Change Distance Between Columns
Select any column. Open the Format pane, be sure the title says Format Data Series.
Click on the Options button. m
From here you can:
e Change the selected series to be on a secondary axis
e Change the distance the series overlap
e Change the width between the each category grouping
Explode a Pie Chart

In the chart: Hover over a pie wedge. Click and drag the piece away from the center. To move one piece at a
time, select the single pie wedge first, and then move it from the middle.

In the properties: Select a pie wedge. Open the Format pane, be sure the title says Format Data Series.
Click on the Options button. m
From here you can:

e Change the rotation without changing the order of the data

e Change the explosion, how close the wedges are to each other

Add Trendlines and Error Bars
Select the chart. Click on the Add Chart Element button in the Design tab, or on the D button next to the chart.

You can add your own custom error bars, if needed, from the error bar options. You do have to format one
series of error bars at a time.

Make Charts the Same Size
Use the Height and Width properties found on the Format tab in the ribbon, or on the Format Pane for the Chart
Area's Size & Options. You can use the alignment options on the format tab to make the charts line up.
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Changing the Data Source

From the Worksheet

When you select a chart you will see the Chart Tool ltem 1st Qtr  2nd Qtr  3rd Qtr | 4th Qtr
tabs in the ribbon, and the three options buttons along ||pants 456 489 493 A68
the right side of the chart. If you can see the cells in Shoes 408 435 A7? 436
the worksheet used for the chart you will also be able Socks 128 168 157 138
to see the data is selected and each section is shaded.
If you hover your mouse over the bottom right-hand Chart Title *
corner of the data grouping you will get the two-way 600 4
sizing arrow. If you click and drag the selection you can 400 II II -
manually change the chart data source. 200

. ml Y
If you know you will have more categories and series Pants shoes Socks

you can grow the data area beyond what's showing
and Excel will assign new colors and make room in the

N 1stQtr W 2nd Qtr 3rd Qtr

chart for the new values.

From the Select Data Source Window

. r . -

From the Chart Tools Design tab choose Select Data. Select Data Source P [
Chart data range: | =' Sales by Quarter'! $B$2:5E55

The Chart data range option can be a bit finicky so |

recommend deleting the current range and selecting [Eisunch RowGohumn

h new fr m h w rk h . Legend Entries (Series) Horizontal (Category) Axis Labels

the new set from the worksheet maas | s Jxmmon] < (=] [P |
1st Qtr Pants

The chart is initially arranged to follow the order of the 2nd qr Shoes

. . . . 3rd Qtr Socks

data, but if you would like the legend in a different order, I

you can rearrange the Legend Entries using the up and

down arrows.

Removing data

Both of the above options will help you add and remove data. You can manually adjust the range in the
worksheet or you can select a different range from the Select Data Source window. Both are great as long as you
are using a consecutive range of data.

The Select Data Source window also had a Remove button to delete a series from Values | Names
the chart. Notice there is not one for the Category/Axis labels. To be able to remove “ Sj”e;elmm
one you will need to first Switch Row/Column. Once you've removed the categories, 21
Switch Row/Column again. 71 2nd Ot
v I 3rd Qir
From the chart itself you can click on the series you want to remove and press Delete 4 Cj“i’s"e'z;m
on the keyboard. You can only delete the series, so the same actions apply in order U o
to remove a category you will need to switch the row/columns first. 7 shoes

¥ Socks
However, we now have a Filters button along the side of the selected chart. From
here we can uncheck any of the values we do not want on the chart; Series and
Categories. You must click the Apply button at the bottom of the menu for the filter
to take effect.

onth Apply Select Data...
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Types of Charts
Column and Bar Charts

Clustered Column Insert Column or Bar Chart
e Use this chart type to visually
S0 compare values across a few
o categories.
400
S Click the arrow to see the different
00
: types of column and bar charts
e - - available and pause the pointer on
0 ; : .
Pants Shoes ik Blouses Hats the icons to see a preview in your
mistQtr m2nd Qtr ®3rd Qtr W4th Qtr chument
3-D Clustered 3-D Column
600
500
400 600
= 500
400
200 300 Ath Qtr
200 3rd Qtr
100 100 2nd Qur
0 o 1st Qtr
Pants Shoes Socks Blouses Hats Pants Shoes Socks Blouses Hats
WistQtr W2nd Qtr ®3rd Qtr W4Ath Qtr WlstQtr ®W2nd Qtr = 3rd Qtr M4th Otr
Stacked Column 3-D Stacked Column
2500
2500
2000
2000
1500
1500
1000
1000
b - ” 3 9
o — o
Pants Shoes Socks Blouses Hats Pants Shoes Socks Blouses Hats
EistQtr m2nd Qtr ®3rd Qtr W4th Qtr WlstQtr ®W2nd Qtr = 3rd Qtr M4th Otr
100% Stacked Chart 3-D 100% Stacked Column
100%
9% 100%
B0%
700 B0%
60%
S0% 60%
40%
40%
30%%
20% 200
10%
0% 0%
Pants Shoes Socks Blouses Hats Pants Shoes Socks Blouses Hats.
WistQtr W2nd Qtr ®3rd Qtr W4Ath Qtr WlstQtr ®W2nd Qtr = 3rd Qtr M4th Otr
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Clustered Bar 3-D Clustered Bar
Hats Hate
Blouses Blouses
Socks Socks
Shoes Shoes
Pants Pants
0 100 200 300 400 500 600 700 0 100 200 300 400 500 600
W4athQir m3rd Qtr W 2nd Qtr W st Otr WathQir m3rd Qtr W 2nd Qtr W 1st Otr
Stacked Bar 3-D Stacked Bar
H
slouses | S I 00
Blouses
socks NN socks DD
shoes | o N 2020
pants | S rants (D
o 500 1000 1500 2000 2500 o 500 1000 1500 2000 2500
WistQtr W2nd Qtr ®3rd Qr W4Ath Qtr WilstQtr ®W2nd Qtr W 3rd Qtr W4th Otr
100% Stacked Bar 3-D 100% Stacked Bar
. | T —
Hats
elouses | I 0
Blouses
socks | e |
shoes - | S . e @300 B
pants | S rarts
0% 208 A0% 60% 805 100% 0% 20% A0% 6% 80% 100%
WistQtr W2nd Qtr ®3rd Qr W4Ath Qtr WilstQtr ®W2nd Qtr W 3rd Qtr W4th Otr
Line and Area Charts
3-D Line Insert Line or Area Chart
Use this chart type to show trends
600 over time (years, months, and days)
. or categaries.
200 ath e Click the arrow 1o see the different
3rd Qtr -
0 25 types of line and area charts
Pants  ghoes Socks 1stQrr available and pause the pointer on
| R . R
BIOUSES Hats the icons to see a preview in your
mistQtr ®W2nd Qtr = 3rd Qtr W4Ath Otr dDCUﬂ"IEﬂ't.
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Line

Line with Markers

700 700
600 600
500 500
400 400
300 300
200 200 —
— — — 4
100 100 > —
0 0
1stQtr 2nd Qtr 3rd Qtr 4th Qtr 1st Qtr 2nd Qtr 3rd Qtr ath arr
—PANTS  e—Shoes  ee—Socks  e—(louses es—Hats =—P==Pants ==@e=Shoes =@=S0cks ==@==plouses =—@=Hals
Stacked Line Stacked Line with Markers
2000 2000
1800 1800 [ - ™
1600 1600 o - —
1400 1400
1200 1200
1000 1000 —
800 800 s —
600 600
400 400 L= —a
200 200
0 0
1stQtr 2nd Qr 3rd Qtr 4th Qtr 1st Qtr 2nd Qtr 3rd Qtr 4th Qtr
—PANTS  e—Shoes  ee—Socks  e—(louses es—Hats =—P==Pants ==@e=Shoes =@=S0cks ==@==plouses =—@=Hals
100% Stacked Line 100% Stacked Line with Markers
100% 100% L, & & ®
9086 905 -
i1 808
700 T00%
G0%% G0%% G =
508 508 — = -
40% 40%
30% 309 —g= — —
20% 20%
10% 10%
0% 0%
1st Qtr 2nd Qtr 3rd Qtr 4th Qtr 1st Qtr 2nd Qtr 3rd Qtr 4th Qtr
—PANTS  e—Shoes  ee—Socks  e—(louses es—Hats =—P==Pants ==@e=Shoes =@=S0cks ==@==plouses =—@=Hals
Area 3-D Area
120
100
80
60
40
20 4th Val
3rd Val
g 2nd Val
femt 15t Val
Item 3
Item 4
Item 1 Iltem 2 ftem 3 Item 4 Iltem 5 Item 5
milstval m2ndVal m3rdval m4thval mistvVal ®m2ndVal m3rdval m4thval
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300

Item 1

Stacked Area

Item 2 Item 3 Item 4

mistval m2ndval m3rdVal m4thval

Item 5

3-D Stacked Area

Item 2

Item 4
Item 5

mistVal ®m2ndVal ®m3rdVal m4thval

100%
9056
BO%
700
G0%%
508
A0%
30%
20%
10%

Item 1

100% Stacked Area

Item 2 Item 3 ftem 4

mistval m2ndval m3rdVal m4thval

Item 5

3-D 100% Stacked Chart

100%
B80%
60%
40%
20%

Item 2

Item 3
Item 4
Item 5

mistval m2ndVval m3rdVal m4thval

Pie and Donut Charts

Pie

d 4

= Pants = Shoes = Socks = Blouses w=Hats

Insert Pie or Doughnut Chart

Use this chart type to show
proportions of a whole. Use it when
the total of your numbers is 100%.

Click the arrow to see the different
types of pie and doughnut charts
available and pause the pointer on
the icons to see a preview in your
document.

3-D Pie

= Pants ® Shoes = Socks = Blouses = Hats

Doughnut

M Pants MShoes MSocks ®Blouses M Hats
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Pie of Pie

= Pants = Shoes = Socks = Blouses = Hats

Bar of Pie

= Pants = Shoes = Socks = Blouses = Hats

Hierarchy Chart

Tree Map

B Pants M Shoes M Socks M Blouses B Hats

Sunburst

Insert Hierarchy Chart

Use this chart type to compare
parts to a whole, or when several
columns of categories form a
hierarchy.

Click the arrow to see the different
types of hierarchy charts available
and point to the icons to see a
preview in your document.

Statistic Charts

Insert S5tatistic Chart

Use this chart type to show
statistical analysis of your data.

Click the arrow to see the different
types of statistic charts and pause
the pointer on the icons to see a
preview in your document.

[10, 180]

Histogram

(180, 350] (350, 520] (520, 690] (690, 860]

(860, 1030]

Pareto

(350,520] (690,860 [10,180] (520,690] (860,1030] (180, 350]

100%
90%
80%
0%
60%
50%
40%
30%
20%
10%
0%
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Scatter (X,Y) and Bubble Charts

Scatter Insert Scatter (X, Y) or Bubble Chart
:: o Use this chart type to show the
o Sl " relationship between sets of values.
soo [® ? &
P . Click the arrow to see the different
300 . types of scatter and bubble charts
200 ° available and pause the pointer on
100 . . the icons to see a preview in your
’ o 100 200 300 400 500 600 T00 800 900 dDCU[T"IE'.'n't.
Scatter with Smooth Lines and Markers Scatter with Smooth Lines
800
700 |
600 |
500 |
400 |
300 |
200 |
100 |
0 100 200 300 400 500 600 700 800 900 0 100 200 300 400 500 600 700 800 900
Scatter with Straight Lines and Markers Scatter with Straight Lines
800
700 |
600 |
500 |
400 |
300 |
200 |
100 |
o | . . | . | o | . . | . |
0 100 200 300 400 500 600 700 800 900 0 100 200 300 400 500 600 700 800 900
Bubble Chart 3-D Bubble
4000 4000
3000
2000
1000
. g¥geg¥ec®. ‘e [ 0gY9°9, °0
2 7 4 4 6 8 10 12 14 16 -2 2 4 6 8 10 12 14
-1000 -1000
-2000 -2000
-3000 -3000
@ Seriesl @ Series2  ® Series3 @Seriesl @ Series2 @ Series3
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Radar and Surface Charts

Radar

Filled Radar

Jan

Insert Surface or Radar Chart

Mov Aug Oct

Jul

Apr lan Dec Sep Jun

mO0-1000 = 1000-2000 = 2000-3000

Seriesh

SeriesS

Seriesd

Series3

Series2
Seriesl
Feb Mar May
W 3000-4000

Mar Click the arrow 1o see the different

types of surface and radar charts
A available and pause the pointer on

the icons to see a preview in your
document.

May

Jul
Contour Contour

Seriesd

Series3

Series2

Seriesl

Q-2 m2-4 W46 m6-E WE-10

Wireframe Contour

Wireframe Contour

/ \ \ | Seriesh
N / 7 7 Seriesd
Seriess |‘=\ \\ // >\\. / W \\!/ )
\ ._.,’// | ».\_\\ /,
i Series3
Seriesd \ .,
\ / \
: \\ > k[\\ / W \/N
Series3 \ i ~ .
— T~ Series?
Series2 N A | m
4 <= r Seriesl
Seriesl 1 2 3 4 5 6 7 8 9 10 11 12
Mov Aug Oct Apr Jan  Jul Dec Sep Jun Feb Mar May
00-1000 0O 1000-2000 [O2000-3000 O 3000-4000 o2 024 D46 O6-8 O8-10

Wireframe 3-D Surface

4000 10
3000 8
6

2000 4
1000 2
0 SeriesS 0

Nov Series3
Aug Oct Apr
Dec  gep Jun Seriesl
Feb  par
May
00-1000 0O1000-2000 [CO2000-3000 0O 3000-4000

Wireframe 3-D Surface

002 O2-4 046 O6-8 O8-10

Page 15




Class Exercise

Explore workbook

Open ChartData.xlsx COLUMN TITLE COLUMN TITLE
View each worksheet ROW TITLE DATA DATA
Discuss 'consistent’ range of data RSN Dl DATA

Create Chart

Turn to Sheet 'Sales by Quarter'

Turn to the Insert Tab

Click on Recommended Charts
0 Click on each suggestion to see a preview of our dataset
0 Click on the ALL CHARTS page at the top of the window and explore the options
0 Choose first Column Chart

Chart Tool tabs — Design and Format

Click outside of chart to deselect

O Tabs disappear

Design Tab

Add Chart Element
O Add: Data Labels on the Outside End
O Remove: Chart Title
0 Move: Legend to the top
Explore different Quick Layouts
0 Choose first layout (title above, legend on right)
Explore different Chart Colors
Explore different Chart Styles
0 Notice it changes the Chart Layout
0 Return to the Quick Layout menu and choose the first one again
Switch Row/Column
0 Notice it's switching the legend with the category axis
0 Leave the chart with quarter in the legend
Select Data
0 Rearrange legend 4™ Qtr - 1°t Qtr
0 Cancel the window
Change Chart Type to different options
O Reset it back to the original, first column chart

Move chart to its own sheet
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Format Tab — Current Selection

- Select Legend from Current Selection dropdown

- Click Format Selection button

0 Legend Options

o Fill
| |
| |
O Border
| |
| |
0 Effects

Move legend to different positions

Try it with overlapping the chart

Solid Fill
Gradient Fill
e Preset Colors
Picture or Texture Fill
e Textures
e Insert afile

Solid line
Increase width
Gradient

Add a Shadow
Add a Glow

- Inthe Format tab in the ribbon, click Reset to Match Style

Layout Tab — Insert

- Insert Shapes

0 Insert Block Arrow

0 Uses yellow diamond to modify arrow

0 Use green circle to rotate

0 Delete

- Insert Text Box

0 Typeinside

0 Move around

O Delete

700

Pants

Hats

15t Quarter
® 2nd Quarter
 3rd Quarter
 4th Quarter

Delete Chart

- Right-click on Chart 1 Sheet name

- Select Delete

- Confirm deletion
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Create Chart

- Turnto Sheet 'Sales by Year

- Insert Tab, Chart Group, Column
0 Choose first Column Chart

- Move to a new worksheet

- Change Font
0 Right-click on Category Axis (pants, shoes...)
0 Choose Font, sent size to 14
0 Undo
O Right-click in Chart Area (blank space)
0 Choose Font, sent size to 14

- Change Title to read "Yearly Sales

- Add Minor Horizontal Gridlines

0 So you have Major and Minor lines

Format Tab - Styles

Select Major Gridlines

Change Shape Styles
0 Use Preset options
0 Use Shape Outline
0 Use Shape Effects
- Select a column
- Change Shape Styles
O Use Preset options
0 Use Shape Fill
0 Use Shape Outline
0 Use Shape Effects
- Format
O Fill, Outline, and Effects for each column, independently
O Fill for Plot Area
O Fill for Chart Area
- Format Chart Title
0 Change font size to 40
0 See Shape Styles, don't change it
O See WordArt Styles
= Text Fill
=  Text Outline

= Text Effects
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Save as Template

Saving the template then closing the file without saving it.
- Right-click on the chart
- Save as Template...
0 'Chartl'is fine
- Exit the file

O Don'tsave

Use Template
- Reopen the Charts file

- Turn to Sheet 'Sales by Year'
- Insert Tab, Chart Group, Column, First chart
- Design Tab - > Change Chart Type
- Templates
O First option in pane on left
- Choose Chart1, Click OK
- Delete Chart

Default Chart
- InSheet 'Sales by year' Press F11

Modify Default Chart
- Innew chart, Design Tab - > Change Chart Type

- Right-click on the Template
- Setas Default Chart
0 Click OK
- Return to sheet 'Sales by year'
- PressF11
- InSheet 'Sales by Quarter' Press F11
0 Note only the first column was formatted

Close but don't save the file

Manually Changing Data Ranges

- Insert a column chart on Sheet 'Sales by Quarter'
- Notice color Coding around original data
- Use fill handle to change the selection
0 If the colors go away, click inside the chart again.

0 Adjust the chart to include only the data
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Remove Data

Click on a column for 4" Quarter
O Press Delete on the keyboard
Click on a column for 2" Quarter

0 Press Delete on the keyboard

Notice the color grouping around our dataset is gone

Switch row/columns to remove your shoes

Switch row/columns back

Open the filters button. There is only the first and third quarter, and no shoes

Delete Chart

Insert a column chart

Use the Filter to remove second and fourth quarter, and remove your shoes

Use the Filter to add them back in

Chart Specific Data

Select Items through 3™ Quarter, A1:D6
Insert a column chart
Delete 2" Quarter

Delete Chart

Select Items through 1% Quarter, A1:B6
Use Ctrl key to select 3" Quarter, D1:D6
Insert a Column chart

Delete Chart

Pie Chart

Turn to Sheet 'Sales by Year

Insert Tab, Chart Group, Pie, First chart
Remove Title & Legend

Add labels for %, Delete labels

Explode Pie

Rotate Pie (in the options)

Pull individual pieces

Delete Chart

.‘I
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3-D Pie Chart

Insert a 3-D Pie chart
Explode Pie
0 Re-connect/Implode
Select Plot Area from the Format Pane
View the effects, 3-D Rotations
Change X & Y rotations
0 Use little scroll up and down arrows
Uncheck Autoscale
Change Height (% of base)
Delete Chart

3-D Column Chart

In Sheet 'Sales by Quarter"

Insert Tab, Chart Group, Column, Last 3-D option

Delete Legend
Design tab - Switch Row/Columns

Design tab — Select Data

O Rearrange Legend so smaller values are in the front

Delete Chart

Line Chart

In Sheet 'Sales by Quarter
Insert Tab, Chart Group, Line, First option
Design tab - Switch Row/Columns
Remove Smaller Values
Move to new sheet
Format Axis Options

0 Minimum 400

0 Maximum 600

0 Major Unit 25

600

1stQuarter

2nd Quarter

3rd Quarter

ath Quarter

——Pants
——shoes

——Blouses

Layout Tab - Analysis

Trend Line

Error Bars
O More Error Bar Options
O Fixed Value 5

Delete Chart
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